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C H A P T E R 16

Performance Management and Historical Data

An important component of efficient network management is the ability to collect and analyze 
performance information in a large network of many devices. This performance information can assist 
you to pro-actively manage your network elements, and troubleshoot network problems.

This chapter describes the Cisco Element Management Framework (Cisco EMF) Performance Manager 
application that is used in conjunction with the Cisco 12000 Manager (C12kM) application to view 
performance statistics from the Cisco 12000 series internet routers managed on your network.

Performance Manager collects historical performance data for interfaces. You can only view 
performance information in Performance Manager if performance logging is switched on. Performance 
Manager is a powerful, flexible tool that enables you to view general and performance specific attributes 
in one application and in a variety of formats (for example, graphs and tables). You define the attributes 
or parameters, choose the objects you want to view, select the date and time of the view, and set the 
summary interval.

Performance logging can be switched on/off globally (that is, for all modules and interfaces below these 
modules) from the Chassis Configuration window. Refer to the “Starting Global Performance Logging” 
section on page 4-9 or “Stopping Global Performance Logging” section on page 4-10 for further details.

Module performance logging can be switched on/off on a per module basis from the Module 
Performance window. Switching performance logging on for a selected module also switched 
performance logging on for the interfaces and VLAN sub-interfaces on the module. Refer to the 
“Starting or Stopping Performance Logging” section on page 5-10 for further details.

VLAN sub-interfaces or interface performance logging can be switched on/off on a per interface basis 
from the Generic Interface Performance window. Refer to “Starting Performance Logging for a Selected 
Interface” section on page 10-5 for further details.

Performance Manager collects data for all different technologies on an interface. For example, if you 
want to view Performance Manager data for an ATM interface, performance attributes are listed for 
Generic and SONET technologies, because both apply to ATM interfaces.

Performance information in Cisco 12000 Manager (C12kM) application can be viewed in two ways:

1. Using Performance Manager to display historical data as well as current data in the form of a line 
chart, bar chart, or table.

2. Using the Interface Performance windows option to view current data in a raw numerical format. 
Refer to Chapter 10, “Interface Performance,” for further information.

This chapter describes the Performance Manager application and the various historical performance 
statistics available on the various objects within the C12kM.
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Performance Information Available Using C12kM
Note Further information on Performance Manager is available in the Cisco Element Management 
Framework User Guide Release 3.2 (78-12536-01), when required.

Performance Information Available Using C12kM
C12kM collects a variety of performance information. The performance information collected can be 
viewed “real time” (as it happens), on a number of Interface Performance windows (see Chapter 10, 
“Interface Performance,”), or as historical information using Performance Manager.

Table 16-1 summarizes the performance attributes that can be monitored for a GRP module and then 
viewed using the Performance Manager application.

Viewing the Performance Manager Window
To view the Performance Manager window, proceed as follows:

Step 1 Right click (on a relevant object icon in the Map Viewer window or from an object pick list) and select 
the Tools>Performance Manager... option. Refer to Table 16-2 on page 16-2 for information on which 
objects allow you to launch the Performance Manager window. The Performance Manager window 
appears, with the Line Chart tab displayed:

Note The Performance Manager window cannot be opened when multiple objects are selected (the menu 
options to open the C12kM windows are grayed out). Available menu options can be launched from 
a site object containing the required objects, when required.

Table 16-1 Monitored Attributes for a GRP Module

Monitored Attribute Description

CPU% performance Displays the percentage of the CPU performance for the selected 
module.

CPU performance averaged over 
1 minutes

Displays the percentage of the CPU utilized for the selected 
module, averaged over a one minute period.

CPU performance averaged over 
5 minute

Displays the percentage of the CPU utilized for the selected 
module, averaged over a five minute period.

Table 16-2 Accessing Performance Manager

Objects (that can be selected) to Open the Performance 
Manager Window Menu Options to Select to Open 

WindowSite Shelf Chassis Module Interface

No No Yes Yes Yes Tools>Performance Manager
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Viewing the Performance Manager Window
The Performance Manager window appears (see Figure 16-1).

Figure 16-1 Performance Manager Window

The Performance Manager window allows you to:

• Identify all Monitored Attributes on a selected managed object. Refer to “Performance Information 
Available Using C12kM” section on page 16-2 for details.

• Identify all time periods configured for sampling each monitored attribute

• Identify all summary methods configured for selected monitored attributes and selected summary 
periods

• View historical performance data over a requested period of time (as a Line Chart, Bar Chart or as 
a Table Display)

• Print performance data to a printer

• Save/export performance data to a file, for subsequent analysis and processing, for example, using 
a spreadsheet application.

Step 2 Proceed to the “Viewing Performance Statistics” section on page 16-4 for details on viewing 
performance statistics.

Select an attribute to
view from the list of

Monitored Attributes
displayed

Enter the Start and
End Time Periods

that you wish to view
the performance

information for

Select the Summary
information

Select the format that you wish to use to view the 
performance information (that is, as a Line Chart, Bar Chart, 
or Table). This example shows a Line Chart.

Click the Refresh
Screen button to

show the
information selected

Select Now to select
the current time and
date as the End time
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Viewing the Performance Manager Window
Note Cisco EMF provides a command line utility (history Admin) that allows mass export of performance 
history data. Refer to the Cisco Element Management Framework User Guide Release 3.2 
(78-12536-01) for further information.

Viewing Performance Statistics
To view performance statistics, follow these steps:

Step 1 Open Performance Manager. Refer to the “Viewing the Performance Manager Window” section on 
page 16-2 for further details.

Step 2 Choose the attribute you wish to monitor in the Monitored Attributes panel (for details on this panel, 
refer to the “Performance Manager Window—Detailed Description” section on page 16-7). You can 
choose multiple attributes in a list by holding down the Shift key and then selecting the first and last 
attributes in the list. You can choose multiple individual attributes by holding down the Ctrl key and 
clicking on individual items. 

Note Only the first selected attribute is shown in the line chart or bar chart. The table display tab 
shows all selected attributes.

Step 3 Set the start Date and Time in the Time Period area. Enter the date on which you want to begin viewing 
performance data in the Start Date entry boxes. The format must be mm/dd/yyyy. Enter the time you 
want the performance data to start on in the Start Time data entry boxes. Set a start time and an end time 
using the 24 hour clock notation. The times are inclusive.

Step 4 Set the End date. You have two options when setting the end date. Enter the date on which you want to 
stop viewing performance data in the End Date entry boxes. The format must be mm/dd/yyyy. Or, check 
the Now check box to view the data from the selected start date to the current time. By selecting this 
option, you do not have to update the end date and time fields.

Step 5 Set the end time in the Time Period area. You have two options when setting the end time. Enter the end 
time at which you wish to stop viewing performance data in the End Time entry fields. The format must 
be mm/dd/yyyy. Or, check the Now check box to view the data from the selected start date to the current 
time. By selecting this option, you do not have to update the end date and time fields.

Step 6 Choose the summary interval from the drop down list in the Summary area. The summary interval is the 
period of time over which the rule is applied. This varies according to the attribute selected. You can 
choose the Raw option, which displays performance data in its most detailed format, not summarized.

Note The performance information corresponds to the attributes’ raw values. If you choose a 
summary period, the information is displayed according to the summary rule. No summary 
period is associated with raw data.

Note When you choose Raw, the bar chart view is sometimes not available, and the 
Summary Rule option is grayed out.
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Viewing the Performance Manager Window
Step 7 Click Refresh Screen. The Refresh Screen button is grayed out when not available. The Refresh Screen 
button is available for selection when Now is selected, or when any criteria has changed and you have 
moved the cursor away from the changed value by clicking the Tab key or by using the mouse.

The performance information appears as a line chart by default. You can view performance information 
as a Line Chart, a Bar Chart (except when the raw option is selected from the Interval drop down list) or 
as a Table Display by selecting the corresponding tab.

The performance information corresponds to the attributes’ value returned during the raw sampling 
period. When a summary period other than raw is selected, the information appears according to the 
summary rule.

Note In some circumstances (possibly due to C12kM being shut down or a heavy network load), 
polls can be missed. Performance Manager deals with this problem by displaying missed 
polls in red. The missed poll value is replaced by the last valid value collected. Performance 
Manager graphs and charts also indicate when an attribute started and stopped being polled 
due to history storage criteria being added, edited or removed. Start and stop polling events 
are shown in charts and tables. The start polling events point is shown in green, and the stop 
polling events point is shown in red.

A polling events key is displayed for selection.

Viewing a Chart
You can zoom in, zoom out and move around the displayed charts using the key presses detailed in 
Table 16-3. You must first select the chart before using the key presses detailed in Table 16-3.

Table 16-3 Table of Key Presses

Press Action

Right arrow key Moves the chart one unit to the right

Left arrow key Moves the chart one unit to the left

Up arrow key Moves the chart to the bottom

Down arrow key Moves the chart to the top

Shift and Z key Zooms in on the chart’s x axis

Shift and U key Zooms out on the chart’s x axis

Z key Zooms in on the chart’s y axis

U key Zooms out on the chart’s y axis

Shift and F key Fits all information on the x axis in window

F key Fits all information on the y axis in window
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Viewing the Performance Manager Window
Printing a Performance File
You can print performance statistics from the Performance Manager, either as a chart or as a table. A 
chart prints out the information which can be seen in the window, and a table prints out all of the 
performance statistics in a plain text format.

The output is printed by the default printer set up on your network.

Step 1 Open the Performance Manager and select the desired performance statistics.

Step 2 From the File menu, select Print.

Step 3 Choose As Chart or As Table.

Saving Performance Data to a File
Performance data is stored in the Cisco EMF database. It is not exported to ASCII file by default. To 
save performance data, follow these steps:

Step 1 Open the Performance Manager and view the performance statistics you want to save.

Step 2 From the File menu, select Export to File 
or 
click the Save As icon  on the Toolbar.

Step 3 The File Chooser window appears. The left hand panel displays the directories and the right hand panel 
displays the files. Use the scroll bars to locate the desired file. Click Filter to expand the list of options.

Step 4 Choose the file. The full path name of the selected file is displayed in the File Filter box, as well as the 
Choice box.

Note You can save the data to a new location or to a new file. Type in the new names as required 
in the Choice boxes.

Step 5 Click Apply to save the file or Cancel to return to the Performance Manager window.

Archiving
Collected data is archived each day. The applied file name is generated automatically using the format 
mm-dd-yyyy.log. When entries are archived, they are purged from the database. By default, only raw 
data is archived.

Note If more than one purge is carried out in a day, the original log file is overwritten and the information 
stored is lost. After a purge, only the information in the current sample period is available for display.
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Viewing the Performance Manager Window
Note Cisco EMF contains a utility called historyAdmin. HistoryAdmin enables you to selectively export 
performance data for groups in an automated manner.

Refer to the Cisco Element Management Framework User Guide Release 3.2 (78-12536-01) for further 
details.

Exporting A Performance File
Performance data can be exported for use in other applications. To export performance data, follow these 
steps:

Step 1 Open the Performance Manager and view the performance statistics you want to export.

Step 2 From the File menu, select Export to File 
or 
click the Save As icon  on the Toolbar.

Step 3 The File Chooser window appears. The left hand panel displays the directories and the right hand panel 
displays the files. Use the scroll bars to locate the desired file. Click Filter to expand the list of options.

Step 4 Choose the file. The full path name of the selected file is displayed in the File Filter box, as well as the 
Choice box. 

Note You can save the data to a new location or to a new file. Type in the new names as required 
in the Choice boxes.

Step 5 Click Apply to save the file or Cancel to return to the Performance Manager window.

Performance Manager Window—Detailed Description
The Performance Manager window displays three areas: Monitored Attributes, Time Period, and 
Summary. The Performance Manager window also displays three tabs: Line Chart, Bar Chart, and Table 
Display.

Monitored Attributes

The monitored attributes list at the left of the window allows you to select the specific attribute you wish 
to view performance information for. The fields in this list change, depending upon the type of interface 
that you launched Performance Manager from. For example, if your selected interface is was an ATM 
line card, you will be able to select all the performance fields that can be found on the following 
performance windows: SONET Performance, and Generic Performance. Both of these technologies 
apply to ATM line cards, therefore all performance information for both technologies is listed in the 
Performance Manager. This list is extensive.
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Viewing the Performance Manager Window
Time Period

The Time Period area contains two sub-areas: Start and End.

Start

The Start area displays two fields: Date and Time.

Date—Enter the date on which you want to begin viewing performance data. The format must be 
mm/dd/yyyy.

Time—Enter the time you want the performance data to start. Set a Start time using the 24 hour clock 
notation.

End

The Start area displays three fields: Date, Time and Now.

Date—Enter the date on which you want to stop viewing performance data. The format must be 
mm/dd/yyyy.

Time—Enter the time you want the performance data to stop. Set an End time using the 24 hour clock 
notation.

Now—Choose the Now check box to view the data from the selected start date to the current time. By 
selecting this option, you do not have to update the end date and time fields.

Summary

The Summary area displays two drop down boxes: Interval and Rule.

Interval—Choose the summary interval from the drop down list in the Summary area. The summary 
interval is the period of time over which the Rule is applied. This varies according to the attribute 
selected. You can choose the Raw option, which displays performance data in its most detailed format, 
not summarized.

Note The performance information corresponds to the attributes’ raw values. If you choose a 
summary period, the information is displayed according to the summary rule. No summary 
period is associated with raw data. When you choose Raw, the bar chart view is sometimes 
not available, and the Summary Rule option is grayed out.

Step 6 Rule—From the drop down list, choose the Rule to be used. This gives you the option to view data 
summarized according to various rules as defined by the history storage criteria as follows:

• Total—totals all values gathered in the summary period

• Average—takes the average of all values gathered in the summary period

• Trough—presents the lowest value received over the summary period

• Peak—presents the highest value received over the summary period

• LogicalOR—displays either 1 or 0. This is typically used for status flags. Some attributes may have 
only two potential values (such as, true or false; yes or no; 1 or 0). When summaries are generated 
from values such as these, and the logicalOR rule is used, the summarized value is 1 if any value in 
the summary interval is 1. If all values in the summary interval are 0, then the summarized value is 0.
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Viewing the Performance Manager Window
Note The Rule option is not available when the option to view raw data is chosen.

Refresh

Refresh—The Refresh button is blue when it is available. It is grayed out when not available. The 
Refresh button is available for selection when Now is selected, or when any criteria has changed and 
you have moved the cursor away from the changed value by pressing the Tab key or by using the mouse.

Line Chart Tab

The Line Chart tab displays the retrieved data in a graphical format. The X-axis displays the time at 
which the polling was done, and the Y-axis displays the value retrieved or the value when the equipment 
did not respond properly.

Further information regarding the element, units, and missed polls is provided, using the appropriate 
color coding displayed at the top of the chart. Blue represents the values retrieved and red identifies any 
polled values missed.

Bar Chart Tab

The information on this tab is shown as a bar chart with the retrieved data. Blue represents the values 
retrieved and red identifies any polled values missed.

Table Display Tab

The Table tab displays the data retrieved in a tabular format. The first column shows the time of polling, 
and the second column shows the retrieved values. Blue represents the values retrieved and red identifies 
any polled values missed.
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